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Disclaimer
Clinical conclusions and decisions based on the use of this product are the responsibility 
of the user.  The manual provides an operational summary for the Cascade Elite system.  
It does not provide clinical training.  It is assumed that the user has adequate clinical 
training to perform intraoperative neuromonitoring procedures. 

This document may contain technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in future 
revisions of this document. Features and specifications are subject to change without 
notice.

Cadwell does not accept any liability for the use or misuse, direct or indirect, of this 
product. Users must accept all responsibility for any results obtained by or concluded 
from data obtained by the products. The user must accept all responsibility for results 
obtained by software from Cadwell. 

Trademark Notices
Cadwell and Cascade are registered trademarks of Cadwell. Other brand and product 
names are trademarks or registered trademarks of their respective holders.

Cadwell reserves the right to modify, delete, extend, or improve features described 
herein without notice.
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Intent of Setup Guide
This manual is intended as a basic guide to installing and operating your Cadwell 
Cascade Elite. Please refer to the following information sources for more detailed 
information on operating and servicing your Cadwell Cascade Elite.
     • Cadwell Cascade Elite Operator’s Manual. Part number 100821-620
     • Cadwell Cascade Elite Help File. Part number 369028-620. Available with 	
	 installed Cascade application and at www.cadwell.com
     • Cadwell Cascade Technical Manual.  Part number 100820-621
     • Cadwell ES-IX Stimulator Setup Guide. Part number 190262-933
     • Configuring Cascade on Windows 7. Part number 369028-626
     • Cadwell Cascade Installation Instructions. Part number 369028-934
     • Cadwell website. www.Cadwell.com
     • Cadwell Applications & Service Support. See Cascade Customer Support.

Overview
The Cascade® Elite is designed for intraoperative neuromonitoring (IONM) of 
evoked potential (EP), transcranial electrical motor evoked potential (TceMEP), 
electromyography (EMG), and electroencephalogram (EEG) signals. 

Intraoperative neuromonitoring is a means of reducing the risk of permanent 
injury to neural structures during surgical procedures. Changes or 
abnormalities in the recorded signals may indicate that the surgical procedure 
is affecting the neural structure.

The Cascade Elite Intraoperative Monitor measures and displays the electrical 
signals generated by muscles, the central nervous system and peripheral 
nerves. It acquires the data necessary to perform intraoperative monitoring 
of neural pathways to prevent damage to neural structures during surgical 
procedures. 

The Cascade Elite product, in its standard configuration, consists of a base unit, 
power communication module (power/com), and ES-IX stimulator(s) or Estim 
splitters. Software in the unit allows users to create different procedure setup 
files for various kinds of surgical cases.  
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Cascade Elite Intended Use
The Cascade Elite is an electroneurodiagnostic device designed to measure 
and display the electrical signals generated by muscle, peripheral nerves 
and the central nervous system. It will acquire the data necessary for 
electroencephalography (EEG), transcranial electrical motor evoked potential 
(TceMEP),  electromyography (EMG), nerve conduction velocity (NCV, F wave, 
and H reflex), evoked potentials (EP, brainstem auditory, visual, somatosensory), 
and Train of Four (TOF).

The Cascade Elite is designed for use during the duration of the procedure only.
Use of the Cascade Elite is to be administered under the direction of a trained 
physician, surgeon, neurologist, or electrophysiologist in an operating room or 
clinic.

Setup Instructions
Unpacking the System
Congratulations on selecting the Cadwell Cascade® Elite Intraoperative 
Monitoring system! It’s time to unpack the contents of your system. As you 
unpack, please carefully check to make sure the contents of the shipping box 
match the packing slip. 
NOTE:  DO NOT discard any boxes or packing material until all items on the 
packing list are accounted for.
You should receive the following as standard items: 
     • Cascade Elite base unit with detachable power cord
	 • Power/communications module, removable power cord, and
	    power/com cable
     • Backup Cascade installation software CD
     • Two (2) or Four (4), 16-input amplifier extender cables
     • If ordered, Laptop or Desktop computer (with built-in Ethernet connection) 	
	 with AC adapter and/or AC Power Cord

If you purchased your computer from Cadwell, all necessary Windows® and 
Cascade® software is already installed on your computer from the Cadwell 
factory and the network card is configured for use.  There is no need for you to 
install any software. Please put the CDs that came with your system in a safe 
place. They are included as a back-up copy only. Laptop computers may require 
you to make your own backup CDs for the computer.
NOTE:  If you purchased your computer form a source other than Cadwell, you 
must install software, activate the software licenses, and configure the network 
card. Please refer to the Software Setup section of the help file or Operator’s 
Manual.
Please check for any optional items you may have ordered. These may include 
but are not limited to the following:
     • Electrical Stimulator Module(s). (ES5-100, ES5-5, ES5-20 and ES-16)
	 • ES-IX electrical stimulator
     • TCS-1/TCS-1000 Single Output Constant Voltage Transcranial Stimulator
     • TCS-4 Multiple Output Constant Voltage Transcranial Stimulator
     • Other EP stimulation devices such as insert earphones and goggles.
     • ES Detector Module with ES Detector clip(s)
     • 2nd Ethernet Card (Desktop) or PCMCIA Ethernet Card (Laptop) with 		
	 Network cable
     • Instrument cart with instructions, grounding cable and screw, and any 		
	 accessories such as a retractable arm or printer tray
     • Printer with cables and instructions
     • External keyboard
     • External mouse



Position Elite Base Unit
The Cascade Elite comes with mounting and cable guide accessories.  The 
Cascade Elite base unit can be placed right next to the patient’s bed, reducing 
cable lengths, improving signal quality and reducing noise.  The Elite may be 
secured under a Jackson table, clamped on an IV Pole, placed on the floor, 
hung on the bedrail, or mounted to the equipment rack. The Cascade Elite is 
water and dust resistant. The Quick Connectors are water resistant, although 
the Cascade Elite is not designed to be submerged.

Elite Base Unit Connections
The following connections correlate with the peripheral device connection 
indicated in the image of the Cascade Elite base below. 
1. Amplifier Input Extender Cable Jacks (Amps A, B, C and D)
2. Future Functionality
3. Electrical Stimulator/Stim Splitter Module (ESTIM)
4. Evoked Potential Stimulators (EP)
5. Future Functionality
6. Power/Com Module (Connection to PC)
7. High Voltage Stimulators, ESD Detector or LED Goggles/Pad (AUX 1 and 2)
8. Indicator Lights

When powered on, LED lights on the connector panel will indicate system 
status:
		  D - Data: Flashes when there is communication between the main 
	 unit and the computer.
		  L - Link: Lights when there is a connection established between the 
	 main unit and the computer.
		  S - Status: Flashes in various patterns to indicate operation and
	 status information.
		  P - Power: Lights when power is provided to the main unit. 

The Cascade Elite meets IP 66 standards for water and dust resistance. The 
Quick Connectors are water resistant, although the Cascade Elite is not 
designed to be submerged. 

The connectors on the Cascade Elite come standard with Quick Connect 
fasteners. 

Connectors are labeled using text and graphics to indicate the peripheral 
devices that connect to each port.

Please refer to the Peripheral Device Connection section for instructions about 
where each peripheral device connects.

Power/Com Module Connections
1.	 Power Cord (to isolation transformer).
2.	 Laptop PowerCord Connection
3.	 Power/Com Cable (to Cascade Elite base unit).
4.	 Ethernet Cable (to PC).
5.	 Grounding Post (to PC and Trolley Cart).

Peripheral Devices and Connections
It is important to attach stimulators and other peripheral devices to the correct 
connector on the Cascade . 

Peripheral Device Connector Symbol

Amplifier Input
Extender Cable
Records amplifier input.

Amp A-D

ES-IX Stimulator CPN “CPN”

Stimulus Splitters 
ES5-100, ES5-5, ES5-20 and ES-16

Estim

TCS-1/TCS-1000/TCS-4
Transcranial-electrical motor cortex 
stimulator is an FDA-approved 
high-voltage electrical stimulator.

Aux 1 or 2 “AUX 1”, “AUX 2”

Audio and Visual Peripherals 
Headphones, inserts and the 
pattern reversal monitor are audio 
and visual stimulators that must be 
connected to the EP cable port. 

EP

ES Detector Module
The electro-surgery (ES) detector 
mutes EMG audio and pauses 
EP modes when electro-surgical 
devices are being used. 

Aux 1 or 2 “AUX 1”, “AUX 2”

VEP Goggles/LED Pad
The Visual Evoke Potential (VEP) 
goggles are visual stimulators used 
during surgery. 

Aux 1 or 2 “AUX 1”, “AUX 2”
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Getting Started
Turning Equipment On and Off
Do not turn the instrument base on or off while a patient is connected.
To turn the equipment on:
1. Connect the power/com module, amplifier input extender cables,
	 stimulators, and accessories (if not already connected).  
2. Turn equipment on in the following order:
	 • Power/com module (also powers the Cascade Elite base unit)
	 • Computer
	 • Monitor (desktop units only)
	 • Printer (if connected)
NOTE:  If you are using the isolation transformer, you only need to turn on the 
isolation transformer power switch.
To turn the equipment off:
1. Close all programs that are running on the computer.
2. On the Windows taskbar, click Start, Shut Down, select the Shut down 		
	 option, and click OK.
3. Turn off equipment in the following order:
	 • Power/com module (also powers the base unit)
	 • Computer
	 • Monitor (desktop units only)
	 • Printer
NOTE:  If you are using the isolation transformer, turn off only the cart power 
switch. The monitor, printer, and isolation transformer power switches can 
remain on. The next time you start the system, turn on only the cart power 
switch.
NOTE:  You do not need to disconnect the power/com, amplifier input 
extender cables, stimulators, or accessories. You may leave them connected.

Opening and Closing Cascade Software
To open Cascade Elite:
	 • Double-click the Cascade icon on the Windows desktop, or
	 • On the Windows taskbar, click Start, Programs, Cadwell, and then
	    Cascade.
To close Cascade Elite: 
When you close a patient file or exit from Cascade while in a patient file, all 
data is automatically saved to the patient’s file.
	 • To close a patient file without exiting from Cascade: From the File menu, 	
	    click Close Procedure.
	 • To exit from Cascade: From the File menu, click Exit. You can also click 	
	    the Red ‘X’ in the upper right corner. Click Yes to close the Cascade 		
	    software. 
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Configuration of Non-Cadwell supplied 
computers
For computers not purchased through Cadwell, you will need to configure 
Windows 7 and the Ethernet network card prior to installing the Cascade 
application software.

Follow the instructions in document 369028-626 Configuring Windows 7 for 
Cascade.pdf. This document can be found on the installation CD, Files, then 
Documents folder.

Installing Cascade application software 
on Non-Cadwell supplied computers
Prior to installing the Cascade application software, you should have 
completed the configuration process described in the previous section.

Follow the installation instructions (part number 369028-934) that shipped 
with the Cascade software disc. If you do not have these instructions they can 
be found on the IONM support page of the Cadwell website (www.cadwell.
com).

Minimum Computer Requirements
US & Canada regulatory requirements:
Computer and information technology equipment connected to the console 
must be third party certified to UL1950 or IEC950.

European Union regulatory requirements:
Computer and information technology equipment connected to the console 
must be third party certified to EN60950.

Performance requirements:
Refer to Cadwell document 308014-000 for minimum computer performance 
requirements to run this device.

Setup Verification
Follow the instructions in the setup verification procedure (part #: 100820-935) 
that was shipped with the Cascade Elite system.



		

The operator must be trained to be able to recognize the difference 
between signal artifacts and valid biosignals caused by movements, 
interference, or misplacement of sensors or electrodes.

The proper use of this device for its intended purpose can only be 
assured once all instructions have been read and understood. If 
there are any questions regarding the operation of the Cascade 
system, contact Cadwell.

The manual provides an operational summary for the Cascade 
system. It does not provide clinical training.  The user must have 
adequate clinical training to perform procedures.

Place system components where they are safe from contact with 
spilled fluids.  

Wrapping or covering the base unit may cause excessive heat 
buildup leading to amplifier failure.

Patient movement may occur during stimulation leading to 
inadvertent neural injury. Take adequate steps to avoid stimulation 
when patient movement could cause injury.

When delivering stimulation that may cause jaw movement, use 
bite blocks to minimize  the risk of tongue-biting injuries and 
mandibular fracture. Routinely check bite blocks for displacement.

The system is not designed to operate in an explosive environment 
or in the presence of flammable anesthetics.

The system is designed to be used on one patient at a time. Do not 
connect multiple patients to one amplifier.

Avoid accidental contact between electrodes connected to patient 
and other conductive parts, including earth ground.

Avoid accidental contact between unapplied electrodes connected 
to the amplifier and other conductive parts, including earth ground.

Review TCS amplitude-pulse train safety chart prior to performing 
TCeMEPs.

Keep anode and cathode stimulating sites in close proximity.

The Cascade Elite amplifier inputs are Type BF rated. Cadwell ensures 
that no current higher than 50uA flows to or from the applied part if 
mains voltage is inadvertently connected to the patient.  

Transcranial cortical stimulation may not be appropriate for use on 
patients with a history of skull fracture or neurosurgical procedures 
to the head. Skull defects could provide high local current densities.

Cortical stimulation may induce seizures and memory problems 
in those with a history of epilepsy and other disorders with 
predisposition to seizures (e.g. alcoholism). Ensure that necessary 
medical precautions are taken in case of such an episode.

Cortical stimulation may induce seizures and memory problems 
in those with a history of epilepsy and other disorders with 
predisposition to seizures (e.g. alcoholism). Ensure that necessary 
medical precautions are taken in case of such an episode.

Display EEG data during cortical stimulation such that seizure 
activity can be easily detected.

Otherwise unexplained intraoperative seizure and/or arrhythmia 
are indications to abort transcranial or direct cortical stimulation.

The safety of pulse train frequencies below 250 Hz (interstimulus 
interval above 4Hz) for cortical stimulation has not been studied in 
clinical literature.

Operation in close proximity to short wave or microwave therapy 
equipment may produce instability in the electrical stimulator 
output.

This system is not MRI compatible.

The system is not defibrillator proof.

Inspect cables before and after each use. Discard and replace cable 
if insulation is damaged or if the cable or connectors are damaged 
in any manner.

The Cadwell flash stimulator must be at least 12 inches (30 cm) 
away from the patient’s eyes. If used on an anesthetized patient a 
means should be provided to ensure that the eye lids remain closed.

The use of the Cadwell flash stimulator may induce seizures 
in epileptics or people prone to epilepsy.  Persons who are 
photosensitive to light may have convulsions, seizures, or a 
myoclonic reaction to the photic stimulator.  The operator must be 
trained to recognize EEG waveforms and patient symptoms that 
are consistent with a patient’s reaction to photic stimulation.  The 
operator must follow laboratory medical policies and procedures 
when using the flash stimulator to care for the patient undergoing 
photic stimulation.  

When attaching the Cascade Elite system to a recording subject, 
verify that the subject will not become entangled in the wires.  Do 
not allow the electrode wires to wrap around the subjects neck.  

Do not clean Cascade before turning off power supply and 
disconnecting all Cascade components. 

Do not clean Cascade components before turning off power supply 
and disconnecting the amplifier.

Do not attempt to service or repair damaged or inoperable 
equipment.

Some of the warnings listed above are referenced from Safety Standards EN 
60601-1and EN 60601-2-40.
There are applications in which the benefits of the test should be weighed 
against possible adverse effects. This judgment is best left to a skilled clinician 
familiar with the characteristics of the device. These applications include the 
following:
	 • Use of high current stimulator with intramuscular EMG needle 		
	    electrodes
	 • Use of high current stimulator for direct nerve stimulation
	 • Use of current densities for any electrode exceeding 2mA r.m.s./sq. cm
	 • Prolonged, rapid, high current stimulation at any site, especially with 	
	    long pulse durations
	 • Transthoracic stimulation
	 • Stimulation with needles having extremely small surface areas that 		
	    easily exceed 2mA r.m.s./sq. cm. when stimulated
	 • Use during pregnancy
	 • Direct nerve stimulation and direct stimulation of the spinal cord, 		
	    muscle, and brain
	 • Transcranial and direct electrical stimulation of the brain

Safety Information
General Warnings and Precautions

U.S. Federal law restricts the use of this system by, or under the 
supervision of, a physician.

This unit is not waterproof. Do not immerse the base unit, 
power/communications module, stimulus splitters, VEP goggles, 
auditory stimulators, flash stimulator, system cables, or any 
other system components in liquid.

Do not try to service unit. Service is to be done by Cadwell and 
other authorized bodies only.

Adhere to the unit cleaning instructions. Always disconnect 
equipment from power source and patient before cleaning.

Connection of patient to high frequency electrosurgical equipment 
and electroneurodiagnostic equipment simultaneously may result 
in burns at the site of the electrical stimulator and/or amplifier 
electrodes, and possible damage to the electrical stimulator and/or 
amplifier.
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Symbols
Symbol	         Title/Meaning		       Reference

Attention, consult accompanying
documents

IEC 348

or Dangerous voltage IEC 878

or Power ON IEC 878

Power OFF IEC 878

Equipotentiality IEC 878

Type BF equipment. Isolated 
patient connection

IEC 878

Output IEC 878

Symbol	         Title/Meaning		       Reference

or Input IEC 878

Variability in steps IEC 878

Plus; positive polarity IEC 878

Minus; negative polarity IEC 878

Direction of nerve depolarization Cadwell convention

Visual Evoked Potential Display Cadwell convention

Temperature IEC 878

Foot Switch IEC 878

Headphone IEC 417

Amplifier Cadwell convention

Reduction of Hazardous
Substance Compliant

RoHS

Link Cadwell convention

Status Cadwell convention

Data transferring Cadwell convention

Trigger Cadwell convention

EMG/EP/EEG equipment with 
respect to electric shock, fire, 
and mechanical hazards only in 
accordance with UL 2601-1 and 
CAN/CS A C22.2 No. 601-1 (XXXXX)

ITS

Declaration of compliance with 
the provisions of council directive 
93/42/EEC concerning medical 
devices (applies only to equipment 
so marked and only in the 
countries stated on the declaration 
of conformity for the device)

KEMA Medical
Notified Body

Waste Electrical and Electronic 
Equipment. Do not throw in 
standard garbage. Recycle or 
dispose of equipment according 
to regulatory requirements of your 
country

WEEE
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Using Help Files
By accessing the Cascade Help files you can get the same information about 
the operation, terminology, and capabilities of the Cascade as are found in the 
Operator’s Manual.  
The Help files can be accessed during operation of the Cascade software.  From 
the Help pull-down menu, select Cascade Help Topics.
An electronic copy of the Operator’s Manual is available on the software 
installation CD included with your Cascade system.  To access the file, insert the 
CD into the CD reader on your computer. An installation menu should appear. 
Click Explore CD. Open the Documents folder and select Cascade Help File. If 
the installation menu does not appear after inserting the CD, open Windows 
Explorer, right click on the CD icon, choose Explore and double click the 
Cascade Help File icon.

Cascade Customer Support
Contact Information
	 www.cadwell.com
Domestic customers: 
	 Phone: 800-245-3001 or 509-735-6481  
	 Fax: 509-783-6503
International customers: 
	 Please contact your distributor (listings available at www.cadwell.com)
	 or email International@cadwell.com

Support hours
Service department support: Monday through Friday from 6:30 am to 5 pm PST
Application support: Monday through Friday from 6:30 am to 5 pm PST
When to contact Cascade Customer Support
Contact customer support if:
	 • You continue to experience difficulty after troubleshooting a problem. 	
	    Cadwell has a rapid, cost-effective method for troubleshooting and
	    servicing equipment. Most problems can be diagnosed over the 
	    telephone, and repairs can be performed by sending in the defective 	
	    part.
	 • You wish to order optional equipment.
To contact Cadwell for a problem
1. Have your customer identification number and serial number near the
	 phone. Have a person who runs the equipment be prepared to speak 		
	 to a service technician. This person should be able to provide an accurate 		
	 description of the problem. It is best if the person calling is in front of the 		
	 equipment when they call.
2. Call the customer support number, and ask for the service department. The 	
	 Cadwell service technician will determine if an exchange or repair of parts is 	
	 necessary and instruct you on appropriate shipping arrangements.

Regulatory Classification Information
	 • United States: Class II
	 • Canada: Class II
	 • European Union: Class IIB (annexes III & V)
Type of Protection Against Electric Shock
	 • Class I Equipment (with Safety Ground)
Degree of Protection Against Electric Shock
	 • Type BF Equipment (Floating Inputs)
Degree of Protection Against Ingress of Solids and Liquids
	 • IP 65 (Dust and splash resistant)
	 • ES-IX Stimulator meets IP 64 (Dripproof)
Mode of Operation
	 • Continuous
European Legal Entity
CEpartner4U, Esdoornlaan 13
3951 DB Maarn
The Netherlands
Tel: +31 6 516 536 26
URL:  www.cepartner4u.nl

909 N. Kellogg St. · Kennewick, WA 99336
(800) 245-3001 · (509) 735-6481 ph · (509) 783-6503 fx
www.cadwell.com · info@cadwell.com

Compliances
Domestic and International Approvals
	 • Cascade, Cascade Elite, and Cascade PRO are cleared for use by the FDA.
	 • Cascade, Cascade Elite, and Cascade PRO are Health Canada approved.
	 • Cascade and Cascade Elite are EU/CE approved.
Cascade Elite PRO meets the following internationally recognized safety 
standards for Medical Electrical Equipment:
	 • IEC 60601-1 : General Requirement for Safety
	 • IEC 60601-1-1 / EN60601-1-1 : Collateral Standard – Safety requirements
	    for medical electrical systems
	 • IEC 60601-1-2 / EN60601-1-2 : Collateral Standard – Electromagnetic 		
	    compatibility
	 • IEC 60601-1-4 : Collateral Standard – Programmable electrical medical
	    systems
	 • IEC 60601-2-40 : Particular requirements for the safety of 			 
	    electromyographs and evoked response equipment.
	 • UL 60601-1 : General Requirement for Safety
	 • CSA 601-1 : General Requirement for Safety

Operating Environments & Limits
The operating environment for this product should meet the following criteria:
1. An ambient temperature range of 50°F to 104°F (10°C to 40°C).
2. A relative humidity range of 30 percent to 95 percent non-condensing
3. An atmospheric pressure range of 700 hPa to 1060 hPa.

Electromagnetic Compatibility
Please refer to the Cascade Operators Manual for detailed Electromagnetic 
Compatability information.

Disposal of Equipment
At the end of product life, please take care to appropriately decontaminate the 
equipment before decommissioning or sending in to Cadwell for service or 
maintenance. 
Please dispose of equipment under the regulatory requirements of your 
country.

Care, Cleaning and Disposal of Equipment
Please refer to the Cascade Elite Help File on your installation CD for complete 
instructions on the care, cleaning and disposal of your equipment.

Support & Warranty Information
Limited Warranty
Cadwell warrants for a period of one year from the date of purchase, the 
system listed against defects in material and workmanship. Notice of a defect 
and an explanation of circumstances concerning any claim that the system has 
proven defective in material or workmanship shall be given to Cadwell within 
two (2) working days of the discovery of the defect in the system. Upon such 
notice, Cadwell will follow the company service procedures outlined on page 1 
(of the warranty).
Cadwell agrees to retrofit equipment. If the company makes standard 
improvements to components of the equipment covered under this 
agreement during the term of the warranty and if such improvements are 
compatible with the equipment located on the customer’s premises, then 
Cadwell will retrofit such physical equipment at no additional charge. Cadwell 
reserves the right to make changes in specifications, construction or design 
of its products at any time in such a manner as it may consider necessary or 
advisable.
Please refer to the Cascade  Operators Manual for more detailed information 
on product warranties.
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